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LICENSE TERMS AND CONDITIONS

FasTrak SoftWorks, Inc.

Licensor is the owner of all rights, including the copyright, in and to that certain set of executable computer programs identified

in the Registration Form, including design and structure thereof (the "Software"), together with all manuals and other written or

printed technical material provided with the Software to explain its operation and to aid in its use (the "Documentation").

Licensee wishes to have the right to use the Software, and Licensor is willing to grant such a right to Licensee on the terms and

conditions set forth herein.

1. GRANT OF LICENSE. In consideration of Licensee's payment of the license fee referred to below and Licensee's agreement

to abide by the terms and conditions stated herein, FasTrak SoftWorks, Inc. (referred to as "Licensor") grants Licensee a

nonexclusive right to use and display one (1) copy of the Software with respect to one microcomputer at a time for so long as

Licensee complies with the terms hereof. Licensor retains the right to terminate this Agreement and Licensee's rights at any time,

by written notice to Licensee, in the event Licensee violates any of the provisions hereof.

Licensor reserves all rights in and to the Software and Documentation not expressly granted to Licensee herein. Licensee agrees

to pay Licensor the license fee specified by Licensor as of the date hereof, payable in full upon deliver of a copy of the

Software and Documentation to Licensee. Licensee acknowledges that the license fee payable hereunder is consideration solely

for the right to use the Software, and payment thereof will not entitle Licensee to support, assistance, training, maintenance or

other services, or the enhancements or modifications to the Software which may subsequently be developed by Licensor, except

as otherwise expressly provided in this Agreement.

2. LICENSEE'S AGREEMENTS. Licensee agrees to comply with the terms and conditions set forth in this Agreement,

specifically including but not limited to the following:

a. Licensee will take all reasonable steps to protect the Software from theft or use contrary to the terms of this

Agreement.

b. Licensee agrees to pay Licensor additional license fees as specified by Licensor if and to the extent Licensee intends

to use or does use the Software in any way beyond the scope of this Agreement.

c. Licensee agrees not to modify the Software and not to disassemble, decompile, or otherwise reverse engineer of the

Software.

d. Licensee agrees to either destroy or return the original and all existing copies of the Software to Licensor within

five (5) days after receiving notice of Licensor's termination of this Agreement.

e. Licensee agrees not to disclose the Software or Documentation or any part thereof or any information relating

thereto to any other party, it being understood that the same contains and/or represents confidential information

which is proprietary to Licensor.

3. OWNERSHIP OF SOFTWARE. Licensee shall be deemed to own only the magnetic or other physical media on which the

copy of the Software provided to Licensee is originally or subsequently recorded or fixed, as well as any boards, key-locks, or

cables provided for use with the Software, but an express condition of this Agreement is that Licensor shall at all times retain

ownership of the Software recorded on the original diskette copy and all subsequent copies of the Software, regardless of the

form or media in or on which the original or other copies may initially or subsequently exist. This Agreement does not

constitute a sale of any copy of the Software to Licensee.

4. POSSESSION AND COPYING. Licensee agrees that the Software will only be displayed or read into or used on one (1)

computer at a time, at the location designated for notices to Licensee under paragraph 13, below. Licensee may change the

computer on which Licensee uses the Software to another computer at such location. Licensee agrees not to make copies of the

Software other than for its own use, all of which copies shall be kept in the possession or direct control of Licensee. Licensee

agrees to place a label on the outside of all copies showing the program name, version number, if applicable, and Licensor's

copyright and trademark notices in the same form as they appear on the original licensed copy

5. TRANSFER OR REPRODUCTION. Licensee is not licensed to copy, rent, lease, transfer, network, reproduce, display or

otherwise distribute the Software except as specifically provided in this Agreement. Licensee understands that unauthorized

reproduction of copies of the Software and/or unauthorized transfer of any copy of the Software is a violation of law and will

subject Licensee to suit for damages, injunctive relief and attorney's fees. Licensee further understands that it is responsible for

the acts of its agents and employees. Licensee may not transfer any copy of the Software to another person or entity, on either a

permanent or temporary basis, unless Licensee obtains the prior written approval of Licensor which will ordinarily be subject to

payment of Licensor's then current license transfer fee. Such approval will not unreasonably be withheld if Licensee advises

Licensor in writing of the name and address of the proposed transferee, such transferee is suitable in Licensor's sole judgement,

and such transferee agrees in writing to be bound by the terms and conditions of this Agreement. If the transfer is approved,

Licensee must deliver all copies of the Software, including the original copy to the transferee.



6. ENHANCEMENTS AND UPDATES. Licensor may from time to time release updates of the Software incorporating changes

intended to improve the operation and/or reliability of the Software. Such updates will be provided to Licensee at no charge

(except shipping charges and media costs) for a period of twelve (12) months from the date hereof, and Licensee agrees to install

all updates designated by Licensor as mandatory. Licensor may also offer enhanced versions of the Software from time to time

incorporating changes intended to provide new or enhanced features and/or capabilities, at such license fees as Licensor may

from time to time establish.

7. LIMITED WARRANTY AND DISCLAIMER OF LIABILITY. LICENSOR HAS NO CONTROLOVER THE

CONDITIONS UNDER WHICH LICENSEE USES THE SOFTWARE. THEREFORE, LICENSOR CANNOT AND DOES

NOT WARRANT THE PERFORMANCEOR RESULTS THAT MAY BE OBTAINED BY ITS USE. HOWEVER,

LICENSOR PROVIDES THE FOLLOWING LIMITED WARRANTY:

Licensor warrants, for a period of twelve (12) months only, that the Software shall be free from significant programming errors.

Licensor further warrants that it has full power and authority to grant the rights granted by this Agreement with respect to the

Software and that the use by Licensee of the Software and Documentation will not infringe the rights of others. In the event

Licensee believes that it has discovered one or more significant programming errors, Licensee shall immediately notify Licensor

of such fact in writing. If such notice is received by Licensor within twelve (12) months from the date hereof, Licensor shall,

within a reasonable time, subject to the demands of Licensor's other customers and subject to delays beyond Licensor's control

(including but not limited to labor trouble, illness, delays in shipment of materials, and bad weather), at Licensor's expense,

correct the programming errors. In the event Licensor is unable to correct the programming error within a reasonable time,

Licensee may elect to terminate this Agreement and receive a refund of the licensee fee paid hereunder. For purposes hereof, a

programming error is "significant" only if, as a result thereof, the software does not substantially perform the functions

described in the Documentation. Licensor does not warrant that the operation of the Software will be uninterrupted or error

free. EXCEPT FOR THE ABOVE EXPRESS WARRANTY, LICENSOR MAKES AND LICENSEE RECEIVES NO

WARRANTIES, EXPRESS, IMPLIED, STATUTORYOR OTHERWISE, AND LICENSOR SPECIFICALLY DISCLAIMS ANY

IMPLIED WARRANTY OFMERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

THE REMEDY PROVIDED HEREIN IS EXCLUSIVE. UNDER NO CIRCUMSTANCESWILL LICENSOR BE

RESPONSIBLE FOR DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES OR LOST

PROFITS. LICENSEE ACKNOWLEDGES THAT THE LICENSE FEE HEREUNDER IS NOT ADEQUATE FOR

LICENSOR TO ASSUMEOBLIGATIONS TO LICENSEE GREATER THAN THE EXPRESS REMEDY PROVIDED

ABOVE.

8. GOVERNING LAW. The validity and performance of this Agreement shall be governed by Wisconsin law, except as to

copyright and trademark matters which are governed by United States laws and international treaties. This Agreement is deemed

entered into in Wisconsin. All lawsuits arising out of this Agreement shall be brought in a court of general jurisdiction in

Milwaukee, Wisconsin. Licensor shall be entitled to recover its costs and expenses (including attorney's fees) incurred in

enforcing its rights under this Agreement.

9. WAIVER. The failure of Licensor to enforce any of the provisions hereof shall not be construed to be a waiver of the right to

enforce such provisions at a later time or to enforce any of the other provisions hereof.

10. EFFECT OF TERMINATION. The expiration or termination of this Agreement shall not affect the obligations of Licensee

which by their character are of continuing nature.

11. INTEGRATION. This Agreement sets forth the entire understanding and agreement of the parties shall be bound by any

conditions, definitions, warranties or representations with respect to any of the terms or conditions hereof other than as

expressly provided in this Agreement. This Agreement may only be modified by a writing signed by the party to be charged.

12. BINDING EFFECT. This Agreement shall be binding upon and shall inure to the benefit of the parties hereto and their

respective successors and assigns, subject to the limitations on the transfer of Licensee's rights to the Software provided in

paragraph 5, above.

13. NOTICES. All notices shall be in writing and shall be hand delivered or sent by U.S. mail, first class, postage prepaid, if to

Licensor at its address first above written, and to Licensee at the address indicated in the Registration Form. A party may change

its address for notices at any time by notice to the other party in the manner provided herein, but each party may have only one

address for notices at a time.

14. REGISTRATION FORM. The Registration Form is a part of this Agreement and is incorporated herein by reference. This

Agreement will not take effect, and Licensee will have no rights whatsoever with respect of the Software, unless and until the

Registration Form is duly executed and returned to the Licensor and is accepted by Licensor.
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Chapter 1 – System Requirements

and Installation

Using the Quick Start Guide

Welcome to the Quick Start Guide for the PLC WorkShop for Modicon Suite/Super Suite.

The purpose of this Quick Start Guide is to get you using the software quickly. For this

reason, this guide does not contain comprehensive information about all facets of the

Suite/Super Suite. For detailed descriptions of features, please refer to the online help in-

cluded with each application.

PLC Workshop for Modicon Suite/SuperSuite

Requirements

PLC Support

Supports the entire line of Quantum, Compact, TSX Compact, Momentum, 984, Micro,

and 584 Modicon PLCs
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Operating Systems

Client/Workstations

Windows XP Professional w/SP1 or later

Windows Vista Business or Enterprise

Windows 7 32-Bit or 64-Bit

Windows 8

Windows 10

Database Operating Systems

Windows Server 2003 SP1 or later

Windows Server 2008

Windows XP Professional SP1A or later

Windows Vista Business or Enterprise

Windows 7 32-Bit or 64-Bit

Windows 8

Windows 10

Note: Home/consumer versions of Windows are not supported.

Supported Databases

MS SQL Server 2005

MS SQL Server 2005 Express (included)

MS SQL Server 2008

MS SQL Server 2008 Express
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Communications Support

Supports all methods of communications including Serial with modem support (COM 1–

COM 4), Modbus Plus including Applicom, TCP/IP, and TCP/IP to Modbus Plus Bridges

Hardware Requirements

PC Platform

Recommended – 1 GHz or greater

Memory

Recommended – 512 MB or greater

Hard Disk Space Required

100 MB for client, 525 MB minimum for database

NOTE: You must be logged in as the administrator to install the

PLC WorkShop Suite/Super Suite for Modicon.

Installing the PLC WorkShop for Modicon

Suite/SuperSuite

Installing the PLC WorkShop for Modicon Suite/Super Suite consists of installing PLC

WorkShop for Modicon, Modicon Simulator, and FTVersionTrak. The Suite includes the

basic version of FTVersionTrak (PE), while the SuperSuite include the full version.

Contact Sales if you want to upgrade.

Installing PLC WorkShop for Modicon

1. Insert the PLC WorkShop for Modicon CD in your PC's CD-ROM drive. You must

be an Administrator to install PLC WorkShop for Modicon.

2. The setup program should start automatically. If not, manually run the setup pro-

gram. (The set up program can be found at x:\setup.exe, where x is the letter of the

CD-ROM drive).

- 9 -



PLC WorkShop Suite for Modicon Quick Start Guide

Chapter 1 – System Requirements and Installation

3. To install PLC WorkShop for Modicon, click INSTALL MODWORKSHOP and

follow the instructions that appear.

4. To install 505 Simulator, click INSTALL MOD SIMULATOR and follow the in-

structions that appear.

5. When the installations are completed, click EXIT.

6. Remove the PLC WorkShop for Modicon CD from your PC.

Installing FTVersionTrak

Please refer to the FTVerisonTrak installation guide.

- 10 -



Chapter 2 – Using FTVersionTrak

Using FTVersionTrak with PLC WorkShop for

Modicon

This guide describes using the basic version (FTVersionTrak PE), as well as the complete

version (FTVersionTrak). The Suite includes FTVersionTrak PE, while the SuperSuite in-

cludes FTVersionTrak.

After installing FTVersionTrak, do the following to create a repository and begin ex-

periencing the benefits of using FTVersionTrak to track, manage, and compare changes to

your PLC WorkShop for Modicon program files.

To create your FTVersionTrak repository:

1. Start your PLC WorkShop for Modicon application.

2. At the top of the PLC WorkShop for Modicon window, you should see the fol-

lowing FTVersionTrak toolbar:

3. Click the button on the toolbar to launch the FTVersionTrak client. The fol-

lowing dialog box appears. (Note: Users of the PLC WorkShop for Modicon
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SuperSuite will need to select a server first. See the online help for detailed in-

formation.)

4. Enter a name for your FTVersionTrak repository and click OK to create the re-

pository. Once the repository is created, you may close the FTVersionTrak client.

Certain aspects of the PLC WorkShop for Modicon environment are different when your

PLC WorkShop for Modicon programs are protected by FTVersionTrak. Most differences

occur automatically when opening and closing PLC WorkShop for Modicon files. All other

version control features can be accessed using the FTVersionTrak toolbar.

FTVersionTrak Toolbar

The FTVersionTrak toolbar consists of buttons that represent version control options avail-

able in PLC WorkShop for Modicon. View the FTVersionTrak toolbar by clicking

FTVersionTrak Toolbar on the Toolbars menu.

Button Function

Connect to the FTVersionTrak repository and add the active program

Get a version of the active program file and place it into your working dir-

ectory

Check out the active program

Check in the active program

Undo checkout of the active program

Compare the working copy of the active program to the version in the re-

pository
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View the version history of the active program

Electronically sign the active program

Launch the FTVersionTrak client application

Adding Files to the FTVersionTrak Repository

Before FTVersionTrak can begin securing your program files, they must be added to the

FTVersionTrak repository. The repository is a secure, compressed database that exists

apart from you local file system. This database keeps track of any changes made to the files

added to it, as well as securing them from accidental or unauthorized deletion or removal.

To add a PLC WorkShop for Modicon file to the FTVersionTrak repository:

1. Open the program file in PLC WorkShop for Modicon.

2. Click on the FTVersionTrak toolbar. The Bind File to Repository dialog box ap-

pears.

3. Under Location, click Browse. The Select Repository Folder dialog box appears.
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4. By default, no repository folders have been created. Click OK to add your program

file to the root of the repository (this can always be changed later). Click OK to re-

turn to the Add File to Repository dialog box.

5. Click OK in the Add File to Repository dialog box. The program is added to the re-

pository, and FTVersionTrak will begin to manage the changes to your program.

Opening PLC WorkShop for Modicon Files

Once a PLC WorkShop for Modicon file has been added to the FTVersionTrak repository

and the latest version placed in your working directory, FTVersionTrak's seamless in-

tegration automates the version control process. Follow this procedure when opening PLC

WorkShop for Modicon files protected by FTVersionTrak for best results:

1. After launching PLC WorkShop for Modicon, open the program by clicking Open

on the File menu or by clicking the toolbar button. The Open Program dialog

box appears.
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2. Click Browse and browse for the file. The file should be located in the directory

specified in the get operation. Select the file and click Open. Click OK in the Open

Program dialog box.

3. FTVersionTrak compares your version of the program with the version stored in the

repository. If a newer version of the program is available, a message appears, al-

lowing you to get the latest version.

l Click Yes to get the latest version.

l Click No to open the older version of the program.

4. FTVersionTrak then verifies the check out status of the file. If the file is checked

out to you, it opens normally. If not, a message appears, allowing you to check out

the file.
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l Click Yes to check out the file.

l Click No to open the file without checking it out.

l The program opens in PLC WorkShop for Modicon.

5. After the program opens, the FTVersionTrak toolbar becomes active. The actions

available using the FTVersionTrak toolbar pertain to the active program.

Saving PLC WorkShop for Modicon Files

Edits to PLC WorkShop for Modicon files protected by FTVersionTrak are not complete

until they have been saved and checked in. PLC WorkShop for Modicon automates this

process to prevent accidental loss of changes to the program. The following processes il-

lustrate the various scenarios a user encounters when attempting to save a PLC WorkShop

for Modicon file protected by FTVersionTrak.

Saving a PLC WorkShop for Modicon File That Has Not Been Checked

Out

If you attempt to save a file that is tracked by FTVersionTrak, but not checked out, then

you will be prompted to check out the file.
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Clicking Yes displays the Check Out dialog box. After the file is checked out, PLC

WorkShop for Modicon saves the file.

NOTE: Depending on the FTVersionTrak Options set in PLC

WorkShop for Modicon, available by clicking Ap-

plication Setup on the Options menu, you may be

prompted to check in the file after it has been saved.

Otherwise, you can check in the file by clicking in

the FTVersionTrak toolbar.

If you click No, the Save As dialog box appears. If the file is not checked out, you must

save the file with a different filename to keep any changes made to the file.

Saving a PLC WorkShop for Modicon File that is Currently Checked

Out

When you choose to save a program that is checked out to you, PLC WorkShop for

Modicon can also check in the file for you automatically. Clicking Application Setup on

the Options menu displays the FTVersionTrak Options available in PLC WorkShop for

Modicon. Selecting the Ask to Check In File After Save check box displays the following

message after each save:

Clicking Yes displays the Check In dialog box. After the file is checked in, PLC WorkShop

for Modicon keeps the file checked out to you so that you may continue editing the pro-

gram. ClickingNo saves the working copy on your computer but does not write any

changes to the FTVersionTrak repository. The file can be checked in manually by clicking

on the FTVersionTrak toolbar.
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Closing PLC WorkShop for Modicon Files

The procedure to close a PLC WorkShop for Modicon file is slightly different when the

file is protected by FTVersionTrak. Depending on the file's status, FTVersionTrak offers a

number of different options to the user to prevent the loss of data.

Closing Programs that are Checked Out

If the program file being closed is checked out to the current user, FTVersionTrak displays

a prompt suggesting the file be checked in.

Click Yes to display the Check In dialog box. After the file is checked in, the file closes

normally. Click No to close the file, leaving it checked out.

NOTE: If the file contains edits that have not been saved, PLC

WorkShop for Modicon will prompt the user to save the

file before continuing.

Closing Programs that are Checked In

If a program file being closed has been checked in and no edits remain pending, the file

closes normally. However, if the file being closed is checked in (or has not yet been

checked out) and edits have been made to the program that have not yet been saved, PLC

WorkShop for Modicon will not immediately close the program.

PLC WorkShop for Modicon first prompts the user to save the file.
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l Click No to lose any unsaved changes and close the program.

l Click Cancel to cancel the save and keep the program open.

l Click Yes to save the file. PLC WorkShop for Modicon then prompts the user to

check out the file.

l Click No to display the Save As dialog box and save the file to another file name.

l Click Yes to display the Check Out dialog box.

l Once the file has been checked out, PLC WorkShop for Modicon prompts the

user to check the file back in to the repository.

l Click No to close the program without writing any changes to the repository. The

file is still checked out to the user.

l Click Yes to write changes to the repository and close the program.
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Getting Versions of a File

The Get action retrieves a version of the active program from the repository and places it

in your working directory as a read-only copy to review or check out.

To get a version of the active PLC WorkShop for Modicon program:

1. Click on the FTVersionTrak toolbar. The Get dialog box appears.

2. Select the options of the version you would like to get under Version:

l Selecting Latest Version places the latest version of the file into your working dir-

ectory.

l Selecting Version allows you to choose the version you would like to get.

l Selecting Latest Version of State allows you to choose a version with a particular

repository file state.

l Selecting Labeled Version allows you to choose a version with a particular label.

3. In the To box, enter the directory in which to place the working copy or click

Browse to locate the desired directory. If a working directory has been set, it ap-

pears in the text box. If a working directory has not been set, the text box appears as
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blank.

4. Select the Overwrite working copies checkbox to automatically overwrite any files

located within the directory assigned in the To box with the Get target files of the

same name.

5. Select theMake Writable check box to remove the read-only status from the pro-

gram file.

NOTE: Making working copies writable is not recommended for

files you wish to keep under version control. Do not se-

lect this option if you plan on checking out and editing

the file.

6. Click OK when finished. A version of the file is placed in the selected directory.

NOTE: If the path selected in the To box is the same as the path

of the active program file, the active file will be over-

written even if the Overwrite working copies check box

is not selected. If you proceed to overwrite the active

program file, the program will exit and any existing

changes will be lost. You must open the program again to

continue.

Checking Out Files

To make changes to your PLC WorkShop for Modicon program using FTVersionTrak, it

must first be checked out. Checking out a file places a writable copy of the file within the

user's working directory. If the file is already present in the working directory (following a

Get action, for example) then FTVersionTrak removes the read-only status on the file

while it is checked out.

1. Click on the FTVersionTrak toolbar. The Check Out dialog box appears.
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2. In the To box, enter the directory in which to place the working copy or click

Browse to browse for the directory. If a working directory has been set, it appears

in the text box. If a working directory has not been set, the text box appears as

blank.

3. Select the Do not get local copy check box if you do not wish to get the version

of the repository file while checking the file out.

NOTE: Using the Do not get local copy option only checks out

the file. This is helpful if your working copy is different

than the latest version within FTVersionTrak.

4. If you want, enter a comment about the check out within the Comment box. This

comment may be edited when the file or folder is checked in. Click OK when fin-

ished.

After checking out a file or folder, the following options are available:

l Check In the file or folder to write any edits to FTVersionTrak and create a new

version.

l Undo the Check Out to cancel any changes made to the file or folder.

Checking In Files

Check in the program file to write changes to the master copy located in the FTVer-

sionTrak repository. After you check the file in, other users will be able to Get the
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modified file, view the changes you have made to the file, and check out the file to work

on it as well.

To check in the active PLC WorkShop for Modicon file:

1. Click on the FTVersionTrak toolbar. The Check In dialog box appears.

2. In the Comment box, type a comment for the check in (optional). If a comment

was entered during checkout, it will appear by default in the text box. Select the

Use Checkout Comment check box to use this comment.

3. The From: box will display the local path that the new version will be written from

(usually the working directory). Click Browse to browse to a different directory.

4. Select the Keep checked out check box to write any changes to the repository but

keep the program checked out to you.

5. Select the Delete local copy check box to remove the working copy on your local

system after the check in.

6. Click Compare to compare the differences between the version being checked in

and another version in the repository.

7. Click OK when finished to check in the items.
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Undoing a Check Out

Undo the check out if you decide not to save any changes to the repository or create a new

version of the PLC WorkShop for Modicon program. Undoing a checkout leaves the file in

the state it was in before you checked it out. No new version is created, and no record of

the checkout will be left.

To undo a check out of the active PLC WorkShop for Modicon program:

1. Click in the FTVersionTrak toolbar. The Undo Check Out dialog box appears.

2. Select a Local Copy option:

l Select Replace to replace the local copy of the checked out file with the latest

version within the repository.

l Select Leave to leave the existing copy of the checked out file on your local system.

l Select Delete to delete the local copy from the checkout location. If the file was

checked out to a location other than the working directory, the location indicated

at check out will be deleted and any other copies will be retained.

3. Click OK when finished to return to the main window.
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Comparing PLC WorkShop for Modicon Files

One of the most useful features of FTVersionTrak is the ability to compare the contents of

two PLC WorkShop for Modicon files to each other. Within PLC WorkShop for Modicon,

you may compare two different versions of the same PLC WorkShop for Modicon program

to each other, or compare a version in the FTVersionTrak repository to the working copy

on your local hard drive.

To compare the working copy of the active PLC WorkShop for Modicon program to the

latest version in the repository:

1. Click the button on the FTVersionTrak toolbar. The Compare Files dialog box

appears.

2. Click OK to view the file compare results. See the FTVersionTrak documentation

for more information on file compare results.

To compare the difference between two version of the active PLC WorkShop for Modicon

program:

1. Click on the FTVersionTrak toolbar. The History dialog box appears.
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2. Select the first version of the file you would like to compare. Hold down the CTRL

key and select the second version of the file you would like to compare. Click Com-

pare. The Compare Files dialog box appears.

3. Click OK to view the file compare results. See the FTVersionTrak documentation

for more information on file compare results.

- 26 -



PLC WorkShop Suite for Modicon Quick Start Guide

Chapter 2 – Using FTVersionTrak

NOTE: Clicking Compare without selecting more than one ver-

sion will compare the selected version to the working

copy. Clicking Compare without selecting any version

will compare the latest version to the working copy.

Viewing File History

Each PLC WorkShop for Modicon file that is managed by FTVersionTrak is given its own

history. As you check out, edit, and check in your programs, the history is updated to re-

flect these changes. Viewing history is the best way to get a clear picture of the changes a

program has gone through.

To view the active PLC WorkShop for Modicon program's version history:

1. Click in the FTVersionTrak toolbar. The History dialog box appears.

2. The History dialog box displays all the version information of the selected file. Each

version displayed in the History dialog box contains the following information:

l Version - The version number of the listed version.

l Username - The name of the user that created the listed version.
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l Date - The date and time the listed version was added to the repository.

l State - The version state of the file when it was added to the repository.

l Comment - The contents of the optional comment created when the file was

checked in.

3. The following two optional version histories may be viewed by selecting the ap-

propriate check boxes at the bottom of the History dialog box:

l Show Labels - Select this option to display any associated labels with the re-

pository file. Each label will appear as a separate version of the file, with the tag

Label substituted for the version number.

l Show Electronic Signatures - Select this option to display any associated elec-

tronic signatures with the repository file. Each signature will appear as a separate

version of the file, with the tag Signature substituted for the version number.

4. The buttons on the right side of the History dialog box are used to manage a file's

history:

l Close - Closes the History dialog box and returns to the main window.

l Compare - Selecting a version and clicking Compare will compare the selected

version with the copy in the user's working directory. Selecting two versions and

clicking Compare will compare the two versions to each other.

l View - Launches the application associated with the selected version, and opens

the version of the file within the application as a read-only document.

l Get - Retrieves the selected version of the file to the user's local working directory.

l Sign - Electronically signs the selected version of the file, and allows the option

to change the version state.

l Delete - Deletes the selected version.

l Rollback - Reverts the most recent version of the repository file to the selected

version. Rollback is only available if the file has more than one version, and can

only be selected when a version other than the latest version is selected.

l Properties - View the properties of the selected version, and allow the option to

change the version comment.

l Report - Generates a history report of the selected repository file.
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Electronically Signing PLC WorkShop for Modicon

Files

Electronic signatures can be used as an approval method to verify that a certain user has

seen a selected version of a repository file, and can also be used to advance the version

state of the repository file. FTVersionTrak's electronic signatures conform with portions of

FDA 21 CFR Part 11 regulations.

To electronically sign the active PLC WorkShop for Modicon program:

1. Click on the FTVersionTrak toolbar. The Sign Document dialog box appears.

2. The File and Username boxes are filled with the selected file and current user, re-

spectively. Type the current user's password in the Password box.

3. Select the current version state of the file from the State box and type any com-

ments in the Comment box (optional).

4. Click OK when finished to return to the main window.
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Communications Setup

Use the Communication Setup options to configure how PLC WorkShop for Modicon will

communicate with your PLCs. These options determine the communication parameters

used in standard communication. Another set of options can be configured when the Fast

Connect option is used.

Four communication methods are supported: Serial Ports, TCP/IP, Applicom, and

SA85 Boards. Only one communication method can be used at a time. Use the following

instructions to specify how Modicon WorkShop will communicate with your PLCs.

1. Click Communications Setup on the File menu. The Communications Setup dia-

log box appears.
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2. Click the type of communication you want to configure. For example, to configure

TCP/IP, click TCP/IP. A dialog box containing additional settings is displayed.

For example, a TCP/IP Setup dialog box is displayed if you click TCP/IP.
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3. In the dialog box, specify the settings required for the communication method you

selected. These settings will vary for each communication method. See the online

help for additional information.

4. In the Communications Setup dialog box, select the option button associated with

the communication method you want to use. For example, to use TCP/IP, select

the TCP/IP option button.

5. Click OK.

Fast PLC Connection Setup

The Fast PLC Connect option can be used to quickly connect to a PLC.

Use the Fast PLC Connect Setup options to configure how PLC WorkShop for Modicon

will communicate with a PLC during a Fast PLC Connect. As with the standard connection

option, the FastPLC Connection option supports four communication methods:

l Serial Ports

l TCP/IP
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l Applicom

l SA85 Boards

Only one communication method can be used at a time. Use the following instructions to

specify how PLC WorkShop for Modicon will communicate with your PLCs during a

FastPLC Connect.

1. Click Fast PLC Setup on the File menu. The Fast PLC Connection Setup dialog

box appears.

2. Click the type of communication you want to configure. For example, to configure

TCP/IP, click TCP/IP. A dialog box containing additional settings is displayed.

For example, a TCP/IP Setup dialog box is displayed if you click TCP/IP.
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3. In the dialog box, specify the settings required for the communication method you

selected. These settings will vary for each communication method. See the online

help for additional information.

4. In the Communications Setup dialog box, select the option button associated with

the communication method you want to use. For example, to use TCP/IP, select

the TCP/IP option button. This communication method is the default method

used during a Fast Connect.
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5. Click OK.

Online Mode

In online mode, edits are done in the PLC. Logic, data, and configuration are read from the

PLC memory. Only the documentation is read from the PLC WorkShop for Modicon file

saved on disk (the .fmd file). PLC WorkShop for Modicon offers the following options for

working with programs online:

Performing a Network

Scan

Modbus, Modbus Plus, TCP/IP, and

Applicom networks are scanned for

devices that can attach to WorkShop.

Using Fast PLC Con-

nect

Logic, data, and configuration are

read from the PLC memory. Docu-

mentation is not associated with the

program.

Opening a File While

Going Online

Logic, data, and configuration are

read from the PLC memory, and doc-

umentation from the .fmd file.
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Loading a File While

Going Online (Over-

writes logic on the

PLC)

Logic, data, and configuration from

the .fmd file are transferred to the

PLC (6x Register transfer optional),

and documentation is read from the

.fmd file.

Combining Programs An existing .fmd file is combined

with a program residing on the PLC

for faster online functionality.

Loading an Offline Pro-

gram Online

(Overwrites PLC)

Logic, data, and configuration from

the .fmd file are transferred to the

PLC (6x Register transfer optional),

and documentation is read from the

.fmd file.

Saving a Program from

the PLC to Disk

Logic, data, and configuration from

the PLC are transferred to the .fmd

file and saved with any existing doc-

umentation.

PLC WorkShop for Modicon allows both online and offline programs to be open at the

same time. All programs are opened from the Open dialog box.

Offline Mode

In offline mode, logic, data, configuration, and documentation are edited in the

PLC WorkShop for Modicon file saved to disk (the .fmd file). In offline mode, edits are

performed without involving the PLC in any way.

Creating a New Program

New programs are created in offline mode only. Use the following procedure to create a

new logic program and begin programming:

1. Click New from the File menu, click the toolbar button, or press CTRL+N.

The PLC Type Setup dialog box appears.

- 37 -



PLC WorkShop Suite for Modicon Quick Start Guide

Chapter 3 – Using PLC WorkShop for Modicon

2. Select the PLC Type and the PLC Memory size of the PLC you are using. Note:

With some PLCs, you may need to select additional options, such as Firmware and

Enhanced Execs.

3. If you want to use shared address documentation, click Advanced to display the

Shared Address Documentation dialog boxes and specify the separate database

file.By default, documentation is saved with logic, data, and configuration in the

same .fmd file. However, documentation can be shared with other applications and

programs by saving it in a separate database file.

NOTE: Programs cannot be saved in demo mode.

Opening a File Offline

Logic, data, configuration, and documentation can be edited in the .fmd file without in-

volving the PLC in any way. Do the following to open an existing .fmd file offline:

1. Click Open on the File menu, click the toolbar button, or press CTRL+O.

The Open Program dialog box appears.
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2. Click Browse and select the .fmd file you want to use. .

3. Select the Offline option button

Converting a *.CFG Program

.cfg is the file extension used by ModSoft files. Do the following to convert a .cfg program:

1. Click Open from the File menu, click the toolbar button, or press CTRL+O.

The Open Program dialog box appears.

2. Click Browse and select the .cfg file to be converted. The logic and documentation

of the .cfg file are imported into a new offline program. The new offline program is

saved as a .fmd file.
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NOTE: Programs cannot be saved in demo mode.

Programming Offline

When editing logic offline, the ladder is in Network Editor mode. Edits to each network

are indicated by a change in the background color of the entire network. When edits have

been completed, validate and enter the changes by clicking Validate and Enter on the

Program menu, clicking the toolbar button, or pressing F8. PLC WorkShop validates

the changed networks, and if the networks are valid, enters them in the actual program.

The network background color returns to the normal display..

Programming Online

When editing logic online, the ladder is (by default) in Node Editor mode. The Node Ed-

itor transfers logic immediately to the PLC after an instruction or address is inserted,

replaced, or deleted. Edits to each instruction or address are indicated by a change in back-

ground color of the specific edit. When the edit has been completed, the logic is

transferred to the PLC and the background color returns to the normal display.

Logic may also be edited online in Network Editor mode. However, while the PLC is in

Run mode, network logic and coil values become unpredictable during network download

and may produce unexpected and hazardous results. It is recommended that only an ex-

perienced user attempt programming in Network Editor mode online.

WARNING: Editing or modifying a program online may produce un-

expected or hazardous results.

- 40 -



PLC WorkShop Suite for Modicon Quick Start Guide

Chapter 4 – Using Modicon Simulator

Chapter 4 – Using Modicon

Simulator

Simulator Overview

Modicon Simulator is designed to run and test ladder logic, special functions, PID loops,

Analog alarms, and simulated I/O without the use of a PLC.

Starting Simulator

Use any of the following methods to start the Modicon Simulator:

l Within PLC WorkShop for Modicon, click Mod Simulator from the Viewmenu.

l Within PLC WorkShop for Modicon, click the Simulator button on the

main toolbar.

l Start Windows, click the Start button, click All Programs, click FasTrak

SoftWorks, and then click Modicon Simulator.

After starting, the Modicon Simulator window is displayed:
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Selecting PLC Type

1. Click the Change Type button if you want to change the type of PLC you want to

simulate.

2. Click Accept. The following warning appears:

3. Click Yes. The simulator is now simulating the PLC type you selected.
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Setting Up Communications

Modicon Simulator uses the TCP/IP communication method for connection with PLC

WorkShop for Modicon. Do the following in PLC WorkShop for Modicon to create a new

TCP/IP connection to connect to the simulator:

1. Click Communications Setup on the File menu. The Communications Setup dia-

log box appears.

2. Click TCP/IP. The TCP/IP Setup dialog box appears.
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3. Click Modify. The Communication Settings dialog box appears.

4. In theTCP Port box, enter 502. Click Accept to return to the TCP/IP Setup dialog.

5. In the TCP/IP Setup dialog box, click Add. The TCP/IP Path dialog box appears.
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5. Enter an IP address of 127.0.0.1, which is the localhost (loopback address).

6. Enter a name for this connection (such as Modicon Simulator) in the Path De-

scription box. Click OK when finished to return to the TCP/IP Setup dialog box.

The new path appears in the path list.

5. Click Close to return to the CommunicationSetup dialog box.

6. Click OK to exit and return to the PLC WorkShop main window.
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Connecting to Modicon Simulator

After PLC WorkShop for Modicon and Modicon Simulator are both running, and TCP/IP

communications have been set up using a local host IP Address of 127.0.0.1, connecting to

the simulator is identical to going online to a PLC.

1. Within PLC WorkShop for Modicon, click Open on the File menu or click the

toolbar button. The Open Program dialog box appears.

NOTE: Modicon Simulator must be running before attempting

to connect to it.

2. If you want, select a program to open online by clicking Browse and browsing for a

.fmd file.
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3. Select the Connect to PLC option button and verify that TCP/IP is displayed in

the Connection Method box. If it is not, click Setup and select the TCP/IP op-

tion button.

4. If you are opening a program, verify that the Transfer Logic to PLC check box is

selected and click OK. PLC WorkShop for Modicon is now connected to Modicon

Simulator.
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